QUICK START

A Guide to ArcGIS 10.x for NRCS Soil Scientists
ArcGIS 10.x Quick Start for Soil Scientists

Contents
Transiting to Arc 10.x ............................................................................................................................... 3
Licensing .................................................................................................................................................... 3
Compatibility ............................................................................................................................................. 3
Recommended Data Migration Workflow ............................................................................................. 3
ESRI Online Courses (Virtual Campus) .................................................................................................... 4
Menu changes ............................................................................................................................................... 4
File Menu .................................................................................................................................................. 4
   Add XY Data ........................................................................................................................................... 4
   Create a Map Package .......................................................................................................................... 4
View Menu ................................................................................................................................................ 4
Bookmarks ................................................................................................................................................ 4
Geoprocessing Menu ................................................................................................................................ 5
Customize Menu ....................................................................................................................................... 5
Windows Menu ......................................................................................................................................... 5
Adding and Using Base maps .................................................................................................................... 6
Main Interface Changes ................................................................................................................................ 7
Docking Windows ..................................................................................................................................... 7
Table of Contents – Icons Replace Tabs .................................................................................................. 12
Tables ...................................................................................................................................................... 13
   Table Views, Multiple Tables ............................................................................................................. 13
   Field Options .................................................................................................................................... 15
New Windows ............................................................................................................................................. 17
Embedded Catalog .................................................................................................................................. 17
   Home – the Project Workspace .......................................................................................................... 17
   Default Geodatabase – the “Home” geodatabase .............................................................................. 17
   Preview Data ..................................................................................................................................... 18
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>18</td>
</tr>
<tr>
<td>Results</td>
<td>19</td>
</tr>
<tr>
<td>Editing</td>
<td>20</td>
</tr>
<tr>
<td>Overview</td>
<td>20</td>
</tr>
<tr>
<td>Toolbar Configuration</td>
<td>20</td>
</tr>
<tr>
<td>Primary Display Field – Default Attribute</td>
<td>23</td>
</tr>
<tr>
<td>Snapping Settings</td>
<td>24</td>
</tr>
<tr>
<td>Mini Toolbar</td>
<td>25</td>
</tr>
<tr>
<td>Odds and Ends</td>
<td>26</td>
</tr>
<tr>
<td>Where’s my Spatial Analyst Toolbar?</td>
<td>26</td>
</tr>
<tr>
<td>Reshape and Modify Tools Cause Topology Errors</td>
<td>26</td>
</tr>
<tr>
<td>MS Office 2010 Compatibility</td>
<td>26</td>
</tr>
<tr>
<td>Various Settings</td>
<td>26</td>
</tr>
<tr>
<td>Relative Paths</td>
<td>26</td>
</tr>
<tr>
<td>Make Newly Added Layers Visible</td>
<td>26</td>
</tr>
<tr>
<td>Add Geoprocessing results to Map</td>
<td>26</td>
</tr>
<tr>
<td>Turn OFF Snapping</td>
<td>26</td>
</tr>
<tr>
<td>Turn OFF Mini-Toolbar while Editing</td>
<td>26</td>
</tr>
<tr>
<td>My Toolbox Default Location</td>
<td>26</td>
</tr>
<tr>
<td>Image Analysis in Arc10</td>
<td>27</td>
</tr>
<tr>
<td>Mosaic Raster Datasets</td>
<td>28</td>
</tr>
<tr>
<td>Contacts:</td>
<td>29</td>
</tr>
</tbody>
</table>
Transitioning to Arc 10.x

Licensing
ArcGIS licensing has been simplified in Arc 10.x.
• The purple dongle (USB hardware key) is no longer required
• Soil scientists should all have the ArcInfo level license configured on the local machine
• This means there is NO need to load an additional ArcEditor single-use license; the ArcInfo license should just always be available, like any other software on the local machine
• Consult your state or regional GIS support staff with any questions or issues with license configuration

Compatibility
• Arc 10.x can read/write to previous versions, e.g. 9.x, without upgrading or changing the 9.x version
• Map documents created in Arc 10.x can be saved in previous formats so that they can be viewed in previous software versions. In ArcMap, click **File >> Save a Copy...** and then navigate to directory, name, and select a version from the File type drop down list in the Save As dialog box
• Geodatabases cannot be saved directly as a previous version format. Instead, you must create a new empty geodatabase in the desired version using the Toolbox, and then import the data into this new geodatabase: **ArcToolbox >> Data Management Tools >> Workspace >> Create File/Personal Geodatabase**

Recommended Data Migration Workflow
• Create a 9.x empty geodatabase(s) and store on server
• When you need to create a 9.x geodatabase for user/customer, copy that empty geodatabase, rename, and import data layers, etc., preserving this 9.x empty geodatabase on the server. This saves the step of using the toolbox to create a new empty geodatabase each time. Optionally store feature datasets, base layers, etc., in this 9.x “template” geodatabase
• For existing 9.x geodatabases
  o **Compact** Right-click on geodatabase in ArcCatalog >> Compact
  o **Copy/Paste** Rename copied geodatabase and include version and date stamp, *e.g.* myOldGeodb_9_2_20130101.mdb
  o **Compress** This makes the archived geodatabase uneditable *R-click on geodatabase >> Compress*
  o **Upgrade** – upgrade the ORIGINAL geodatabase, NOT THE ARCHIVE, to your current Arc 10 version: *R-click on the original Geodatabase >> Properties >> Upgrade to Current Version*
ESRI Online Courses (Virtual Campus)

We HIGHLY recommend that ALL soil scientists complete the following FREE online courses:

Start Here: The following course covers the basic changes to the ArcMap interface:
[http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=1822]

The following course covers the new Editing environment:

Menu changes

File Menu
This menu is similar to previous versions, but there are sub-items added under several of the topics:

Add XY Data
To add in tabular GPS location information, Go to File>> Add Data>> Add XY Data

Create a Map Package
Use this feature to create a map package for easy sharing between users. Create the package and then email to another user. The receiver opens the map package which contains a copy of the map document (.mxd) and the data referenced within it. This could be used as an archive mechanism as well as it contains a “snapshot” of a particular time or state of data. Note that the package contains the FULL EXTENT of ALL vector data in the map, not a clip of what is in the current view. Do not attempt to package seamless MLRA-wide soils polygons, for example. Raster data is NOT included so you do not need to remove reference layers, e.g. imagery, DEMs, prior to packaging.

View Menu
The View Menu has the wizards to create Graphs and Reports (formerly on the Tools Menu). It also introduces Pause Labeling as a separate option from Pause drawing.

Bookmarks
The (underutilized) Bookmarks have been pulled out to a top-level Menu and there are some new bookmark management options.
Geoprocessing Menu
This menu provides quick access to commonly used geoprocessing tools, tool environments, and other resources. *Use the Results window to see geoprocessing messages and history.

Customize Menu
This menu replaces the Tools menu from previous versions of ArcGIS. The only items under this menu deal directly with customizing the ArcGIS interface, such as VB Macros, Toolbars, Extensions, and Customize Mode to customize toolbars.

**TIP:** To customize Toolbars and Commands, use **Customize >> Customize Mode**. Note that there are new options on the Options tab. **Uncheck** “Save all customizations to the document” and “Create new toolbars and menus in the document” in order to preserve customization for ALL documents (these settings mean change will be stored in the “normal template”).

**TIP:** Each toolbar has a dropdown arrow in the lower-right corner for quick access to Customize Mode.

Windows Menu
In addition to the Magnifier and Overview windows, have a look at the new options under the Viewer. Also note that you can activate the Table of Contents, embedded Catalog, Search and Image Analysis windows here. Search and Image analysis are described below.
Adding and Using Base maps
ArcGIS 10 allows users to add in Base maps from specific online sources as well as adding information directly from ArcGIS Online (ESRI Global Account is required). Below is the window of available base maps available to add into the map document.
Main Interface Changes

Docking Windows
There are many options for docking windows. In this example, the Identify Window will be docked with the Table of Contents (TOC).

Click and drag the blue title bar of the Identify window. As you move, a blue ‘shadow’ will show you where the window will be placed if you release the mouse button. For example, releasing the mouse in this illustration results with the Identify window moved, but still floating.

The ‘four-way’ targets relate to the window in which they appear. For example, the windows docked using the four-way target in the data frame will span the data frame.
The ‘single’ target arrows indicate positions that will span the entire ArcMap application window.

Four-way targets will appear over other docked windows allowing additional windows to be placed above or below spanning the same width. Example, the Identify window will appear below the TOC, spanning the same width (...or left or right of the TOC, spanning the same height).
Drag the blue title bar of one window on top of the title bar of another window for Tabbed windows. In tabbed view, only one window is shown at a time and tabs at the bottom of the window toggle through the windows.
**NOTE:** Once windows are tabbed, clicking on the blue title bar and dragging will move the entire tabbed group to a new location.

Floating tabbed windows.

**TIP:** To separate tabbed windows, double-click on the active tab. For example, the Identify window is shown (active) above. Double-clicking on the Tab separates the Identify from the TOC.
Unpinning the window or window group results in ‘hidden’ windows. Hidden windows will appear with the name on the side of the ArcMap application. Hover over the window name and the window will “fly out” for access, will fly back to hidden when the cursor moves out of the window.

Unpinned, Window names appear on the side

Click the push-pin icon to produce standard, fixed, docked windows.
Table of Contents – Icons Replace Tabs

List by Drawing Order

List by Source (shows full pathway to all data)

List by Visibility

List by Selection

Options: Table of Contents “patches” changes default symbols for ALL features of a given type. Example, changing default symbol for polygons to “natural areas” changes soils and quadrangles alike.
Tables

Table Views, Multiple Tables
Tables may be docked, pinned or unpinned, like any other windows. See Docking Windows section for more information.

Multiple attribute Tables open only within the same Table window; having two attribute tables open on separate screens is not supported. However, there are several view options for multiple tables.

Tabbed tables (default). Toggle between tables by clicking the tabs at the bottom.

Click the Table menu >> Arrange Tables >> Horizontal OR Vertical

Tip: When multiple tables are open, the Table menu >> Arrange Tables settings apply to the active (visible) table.
Two tables arranged vertically facilitates side-by-side comparisons. Combinations of multiple Table views are possible.

Three side-by-side tables:

Two tabbed tables arranged above (horizontally) a third table:
Field Options
Field settings are accessed primarily through the Data Layer Properties >> Fields tab* (i.e. R-click on data layer in TOC and select Fields tab)

- Choose which fields will be visible when the table is opened using the Checkboxes.
- Rearrange Field order by selecting the field and using the Arrows.
- A field Alias may be used to give a field a more intuitive name (header).

In this example, a number of fields have been turned off (unchecked), the MUKEY has been moved up in the list so it will appear before the MUSYM field, and MUSYM has been given an Alias, “MapUnitSymbol”. Resulting Table when opened in ArcMap:

*TIP: These changes apply to and persist only within an ArcMap document. Changes to the table structure and aliases will persist when saved when an .mxd is reopened. Supply a ‘permanent’ Alias using ArcCatalog >> Properties dialog. Changes to field order cannot be made permanent without manually deleting and recreating fields in the desired order.
Many of these options may be changed back directly in Attribute Table View from the Table Options:

- Turn All Fields On (changes layer Property Settings)
  - Overrides any changes, turns ALL fields on
  - Must use Layer Properties to Selectively turn visibility on/off of individual fields
- Toggle the use of Field Name Aliases
- Restore Default Field Order

The Table Options >> Appearance dialog contains additional options. For example, you may change cell heights in order to long text notes. Note that the default cell height is 115%

Default: Cell Height Adjusted to 300%:
New Windows

Embedded Catalog
ArcCatalog is integrated within ArcMap and includes the following main features:
• Catalog window can be floating, docked, and optionally slide-out or pinned
• You may drag and drop data layers from the Catalog directly into the Table of Contents without using the Add Data icon

Home – the Project Workspace
  o Automatically set to the folder where your current ArcMap document is stored (if saved)
  o If working on an unsaved,Untitled document, the home folder will be in your User profile: C:\Users\first.last\Documents\ArcGIS\Default.gdb
  o The home folder always appears at the top of the ArcCatalog for easy navigation
  o An Home icon allows you to return to this directory with one click
    TIP: The Home icon is available on the Save As dialog so you can quickly select the Home location to store outputs, files, etc.

In this example, the Home directory is C:\Student\DSS\... Next to the Home icon is the Default Geodatabase icon (see below)

Default Geodatabase – the "home" geodatabase
  o Outputs will be saved by default to this geodatabase
  o If no Default Geodatabase is specified, the one supplied in under user profile will be used C:\Users\first.last\Documents\ArcGIS\Default.gdb
  o Set the Default Geodatabase by either:
    ▪ Right-click on the Geodatabase in the Catalog tree and Set as Default
File >> Map Properties, then navigate to the desired geodatabase

- **TIP:** The default Geodatabase icon allows one-click access to this location when either Adding or Saving Data

**NOTE:** While the integration of ArcCatalog generally supports manipulating data in the Catalog window, e.g. renaming data, while it is concurrently being viewed in ArcMap, occasional file/schema locking errors will still occur.

**Preview Data**
Using the ArcCatalog integrated into ArcMap, right-click on the data layer >> View Description; then select the preview tab:

![ArcCatalog preview](image)

**Search**
A new Search window offers revamped and fast search capability allowing users to search for map documents, data, or tools based on search terms. Use this window to search for ArcToolbox tools.

**Example:**
1) Type “clip” into search window
2) Click “Tools” to restrict results

**Note the following features:**
- A pop-up description appears when cursor hovers over each result
- Click on the Tool name to open the Tool directly
- Locate the tool by clicking on the green pathway
Results

ArcToolbox geoprocessing functions now run in the background. The pop-up window that displayed real-time messages during tool execution has been replaced with messaging in the lower right corner of ArcMap. During longer processes, the progress bar and blue font messaging will be shown. When the process completes, a pop-up in the lower right corner will display with a Green Checkmark (success) or Red X (error).

Messages, Results, and geoprocessing History are available through the Geoprocessing >> Results window. Expand sections for more details. The Environmental settings are preserved in Environments.

NOTE: See Geoprocessing >> Ge0processing Options for settings related to how preserving results, adding results to ArcMap by default, pop-up display times, and more.

NOTE: Tool execution may appear to take much longer to initiate than in previous versions. It is easy to assume a simple process run on a small dataset has already run to completion when in fact it has not even begun processing! Monitor the Blue real-time messaging and pop-ups before attempting to view the results or initiate another function.
Editing

Overview
The Editing environment and procedures have seen a major overhaul in Arc 10.x. Most noticeably the Edit Tasks have been replaced with icon-driven edit tools, e.g. a Cut Polygon 'tool' rather than a Cut Polygon edit task. The Edit Target is based on feature Selection, i.e. the active edit tool will operate on any editable selected feature. Our previous editing mantra “Task and Target” is essentially reversed: “Select feature” (target), “Select Edit tool” (task). The new editing environment is a little more streamlined and offers a few enhancements, e.g. vertex editing, snapping, etc., but despite all of the changes to the user interface, much of our workflow will remain the same. Nevertheless, the new approach represents an improvement.

Toolbar Configuration
The Edit Task and Target dropdown menus have been replaced with icons in Arc 10. Many of the tools on the default toolbars are not necessary for soil survey and some may introduce topology errors into your data. Use Customize >> Customize Mode to drag tools off the toolbar to get rid of tools you don’t need (no need to attempt to “file” them, just click and drag them off the toolbar and release). This reduces clutter making it easier to find the tools you will use.

In Customize Mode you can drag and drop tools on and off of toolbars as needed.

TIP: To return to the original default settings: Select Toolbar > click Reset
Customize the Editor Toolbar

A. Edit Tool  
B. Edit Annotation Tool  
C. Straight Segment Tool  
D. Trace Tool  
E. Cut Polygon Tool  
F. Attributes  
G. Create Features

TIP: Tools indicated with arrows are generally not used for soil data development. We recommend removing them using the toolbar Customize Mode to reduce clutter in ArcMap.

Result

! -- These tools, Modify Feature and Reshape feature do NOT honor topology  
Avoid confusion and remove these tools from your toolbar  
Use the Modify Edge and Reshape Edge tools on the Topology Toolbar instead

Now add the “Explode Multi-part Features Tool”.

Result
Customize the Topology Toolbar

**Editing tools that maintain topology**
- Edit Topology Tool A
- Modify Edge Tool B
- Reshape Edge Tool C
- Clear Selected Topology Elements D

**Topology Validation Tools**
- Validated Topology Tools E
- Fix Topology Tool F
- Error Inspector G (a tabular list of errors)

**TIP:** Tools indicated with arrows are generally not used for soil data development. They may be removed using the toolbar Customize Mode to reduce clutter in ArcMap.

**Result**

**Optionally create a New custom Toolbar with All of the Tools you’ll need from both the Editor and Topology Toolbars**

**Example:**

**TIP:** If you opt to create a custom toolbar, be sure to save it so it is available in every new ArcMap session. See Customize Menu section in this document.
Primary Display Field – Default Attribute
The primary display attribute Field or Expression that defines what attribute is displayed in the Edit Merge, Identify, Attributes and Snap Tips windows. Set the Primary Display Field in the Layer Properties >> Display tab

The Merge Window shows AreaSymbol

Change the Display Expression Setting for Mapunit Symbol (MUSYM)
Snapping Settings

The snapping environment is set to snap to visible layer by default. **Enable/Disable** completely using the Snapping Dropdown Menu on the Snapping Toolbar:

**Editor >> Snapping >> Snapping Toolbar...**  **Snapping >> Use Snapping**

To **Create an Island Polygon using Cut Polygon**, use the Snap to Sketch option.

**Snap to a Topology Node** together with **Point** snapping option on the snapping toolbar snaps to polygon intersections only (must be participating in topology)

Find **Snapping Tolerance**, **Snap Tips** in the snapping **Options**
**TIP:** The new snapping environment contains many enhancements and we recommend spending enough time to understand the new options. However, you can revert to the 9.x snapping environment from the main Editor dropdown menu if you prefer: **Editor >> Options >> Use Classic Snapping**

---

**Mini Toolbar**

A new mini toolbar will appear while digitizing. It is only handy for soil survey if you are toggling back and forth between Tracing and manual digitizing – a very rare occurrence. We recommend turning it off. **Editor >> Options >> Uncheck “Show mini toolbar”** (see this option directly below “Use classic snapping” in graphic above)

You may also click the **X** button to temporarily dismiss the mini-Toolbar. Clicking the **Tab** key moves the toolbar out of the way.
Odds and Ends

Where’s my Spatial Analyst Toolbar?
The spatial analyst toolbar has been removed. Use the Spatial Analyst Toolbox instead. Optionally create your own custom toolbar with frequently used Spatial Analyst tools as a replacement.

Reshape and Modify Tools Cause Topology Errors
Most likely you are using the Reshape/Modify Features tools on the Editor Toolbar rather than the Reshape/Modify Edge tools found on the Topology Toolbar. See Editing section in this document.

MS Office 2010 Compatibility
- Arc 10.x reads Excel 2010 files (.xlsx) so there is no need to Save As an .xls
- Arc 10.x does not recognize (read/write) to MS Access 2010 files (.accdb)
  - Personal Geodatabases are created using the .mdb format
- Arc 10.x recognizes Word 2010 (.docx) and PowerPoint (.pptx) files and they may be imported directly into map layouts

Various Settings

Relative Paths
Customize >> ArcMap Options

Make Newly Added Layers Visible
Customize >> ArcMap Options

Add Geoprocessing results to Map
Geoprocessing >> Geoprocessing Options

Turn OFF Snapping
Editor Toolbar Dropdown >> Snapping Toolbar dropdown >> Use Snapping

Turn OFF Mini-Toolbar while Editing
Editor dropdown >> Options

My Toolbox Default Location
This now requires a registry edit (Admin). You may create a toolbox in any location using ArcCatalog >> Right-click >> New >> Toolbox
Image Analysis in Arc10

There is a new window available at all license levels, which deals specifically with image and/or raster analysis. It allows for on-the-fly analysis to the imagery or raster layers loaded into a map document without needing to create a new raster layer. By using this window, you can manage individual or multiple raster layers based on image properties, bands, and pixel classifications easily without going into each layer’s display property.

**Note – It will not work with image map service layers.**

- The top portion deals with the raster layers available within the project
- The middle portion deals mainly with display capabilities and enhancements (all in one place)
- The bottom portion deals with processing (clip, ortho-rectify, etc), filters, and classification. You can export results as a new raster dataset or layer file.

For more information on the capabilities of this window, view the free ESRI training seminar: Visualizing and Analyzing with Imagery with Arc10

Mosaic Raster Datasets

With the Arc 10 release, users can create a mosaic dataset of multiple rasters. It should be used to quickly catalog raster datasets.

- Stored within a geodatabase (must have write-access)
  - Has to have two polygon features within it
    - Footprint – which has the records of images within its attribute table
    - Boundary
- Only available at the ArcEditor or ArcInfo license levels
- Can update, add or remove rasters at any time
- Can create a reference mosaic dataset to maintain an original dataset

For more information, view the free ESRI training seminar: Managing Imagery with ArcGIS 10

http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=1867
Contacts:
This document was developed by the Digital Soil Survey course instructor cadre. In addition to your local, state, and MO GIS support staff, feel free to contact the any of the cadre directly.

Whityn Owen
GIS Specialist – MO1
503-414-3024
whityn.owen@or.usda.gov

Denise Miller
GIS Specialist – South Dakota
605-343-1643, ext 134
denise.miller@sd.usda.gov

Kyle Stephens
SDQS/Database Mgr – MO1
(503) 414-3289
kyle.stephens@or.usda.gov

Bill Teater
Soil Scientist - IL
(217) 241-6635 x 122
bill.teater@il.usda.gov

Edwin Muniz
Assistant State Soil Scientist - NJ
(732) 537-6062
edwin.muniz@nj.usda.gov
Editing

Modify the Edit and Topology Toolbars
Editing Tools for Soil Survey

A. Edit Tool  
B. Edit Annotation Tool  
C. Straight Segment Tool  
D. Trace Tool  
E. Cut Polygon Tool  
F. Attributes  
G. Create Features

Remove: Tools indicated with arrows are generally not used for soil data development. We recommend removing them using the toolbar Customize Mode to reduce clutter in ArcMap.

!! -- Modify Feature and Reshape feature, do NOT honor topology -- !!

Avoid confusion and remove these tools from your toolbar. Use the Modify Edge and Reshape Edge tools on the Topology Toolbar instead.
Commands Tab >> Advanced Edit Tools

Now add the “Explode Multi-part Features Tool”.

Result
Topology Toolbar

Editing tools that maintain topology
- Edit Topology Tool  A
- Modify Edge Tool  B
- Reshape Edge Tool  C
- Clear Selected Topology Elements  D

Topology Validation Tools
- Validated Topology Tools  E
- Fix Topology Tool  F
- Error Inspector  G
  (a tabular list of errors)

Remove: Tools indicated with arrows are generally not used for soil data development. They may be removed using the toolbar Customize Mode to reduce clutter in ArcMap.
Editing

Getting Started
To begin Edit session, select **Editor dropdown >> Start Editing** from the Editor toolbar.

If you have editable layers in your map from multiple geodatabases or directories (folders), you’ll need to select which layer you want to edit.

You may only edit one geodatabase at a time. You may edit all of the feature classes within that geodatabase during the same edit session.

Note: if editing shapefiles, you select a directory and all of the shapefiles in that directory are available to edit during the same edit session.
When you begin editing, the Create Features Window will appear.

A default Edit Template is created for each editable layer in your map *that is visible when Editing is initiated.*

You may simply close or hide this Create Features Window. When editing soils, we rarely need to Create new soil polygons in space using the Create Features tools. Instead, we start with a boundary or existing data and use Cut, Merge, Reshape and Modify to develop new soils data.

**Tip:** If you have dismissed the Create Features Window and need it, you can access it by clicking the icon on the Editor Toolbar.
If you need to manually Create a New Feature but there is no template for that feature, depending on prior steps you may receive an error or you will see the empty Create Features Window.

To create a new template, simply click on the **Organize Template Features** icon …

… select the target data layer from the list and click **New Template** icon

Click **Finish**
Editing

Cut Polygon
Selectable Layers

Cut Polygon requires the user to first select a polygon to be cut. Many other editing tasks operate on the selected features. For this reason, we recommend that you manage the **Selectable Layers** carefully.

Uncheck all layers **EXCEPT** the layer that will be edited. This ensures only the checked layer will be edited.

Here only the ne160_a soils layer is **Selectable**.
An alternative method to create an “island” polygon within an existing area is to use the Cut Polygon Tool.

No overlap topology error is created using this method.

Verify the following snapping settings:
Editor >> Snapping Toolbar

Snapping toolbar >> Snapping Dropdown Menu

Click “Snap to Sketch” if it is not already checked
Use the Select Features tool to select the new polygon
Then click the Cut Polygon Tool
• Note that this time you are drawing a line, not a polygon
• The snapping setting allows us to snap on our starting node to close the polygon
• Using this method, we are cutting into an existing polygon and no topology errors are created
• *Always* Validate Topology to verify
Cut Polygon
  • Select a polygon
  • Click the Cut Polygon from the Editor Toolbar
  • Draw a line through selected polygon
  • Double-click to end

Note: You must cross the polygon edge at least twice, but you may ‘weave’ back and forth across the line as many times as necessary
The polygon is split based on the digitized line.

NOTE:
• Both polygons remain selected
• Both polygons retain the original attributes, thus creating a Common Soil Line.
• Open the Attribute Table and update the MUSYM.
Always Validate the Topology after editing Polygons
Editing

Merge Polygons
Using the Select Features tool, hold down the shift key to Select multiple polygons
Click on the Editor dropdown menu > Select Merge

Select which attribute the new polygon should retain from the Merge Window > Click OK

Note: Click once on a polygon in the list and it will flash in the map display
Always Validate the Topology after editing Polygons
Editing

To edit an existing soil line, use the

Topology Toolbar >> Topology Edit Tools

These tools edit BOTH of the coincident lines at the same time
thus maintaining a clean topology
Use Modify Edge tool to edit vertices

- First, select the edge you wish to modify using the Topology Edit Tool
- The select edge will turn purple
With the edge selected, click the Modify Edge tool

The vertices will be shown as green squares

The Edit Vertices Mini-Toolbar also appears

The Edit Vertices Mini-Toolbar

- Click the “Add Vertex” button on the mini toolbar to add vertices to the edge
- Click the “Subtract Vertex” button to click on vertices to delete
- Using the Select Vertices arrow, draw a box around groups of vertices for multiple edits
Hover over a vertex
When the cursor changes to four outward arrows 🔄, click and drag to move or right-click to delete the selected vertex or vertices

Note: Right-click on the line or a vertex to access a context menu with additional options.
New Vertex Edit Toolbar

When in Modify Edge mode, the Edit Vertices toolbar will appear. New options include:

• Selecting multiple vertices by drawing a box, then move or delete them as a group
• Add Vertex mode which allows you to click multiple times along a selected Edge, inserting vertices as you go
• Delete Vertex mode which Deletes vertices with similar steps
Use Reshape Edge tool to re-draft an entire portion of the polygon shape

- Again, select the edge you wish to modify using the Topology Edit Tool
- The select edge will turn purple
- Next click the Reshape Edge tool and the cursor will become a crosshair +
Draw a new line, left-clicking to insert vertices

The sketch must cross the select edge at least twice, but may cross at multiple locations.
We do not need to worry about overlap errors when digitizing points so we will create new point features

- Select the ne160_p layer from the Create Features Window
- The default tool allows you to just start clicking in the map to ‘drop’ points where desired
Add point features by left clicking, each left click adds a new point feature. The point features do not participate in the topology, so there is no need to check topology when adding points.
Select a point feature and click the attribute button icon. In the “Attributes Dialogue box, you can enter information about the point feature. In this example, we called the symbol “ROC” for rock outcrop.
Snapping Settings

By default, as you draw soil lines the cursor will ‘snap’ to all visible features. There are many options available to control the snapping environment.

Access the Snapping Toolbar via the Editor dropdown menu on the Edit Toolbar.
Snapping Settings

This mini toolbar is handy if you are changing your snapping preferences frequently. This will typically occur when edge-matching or during other data integration tasks.

Limit snapping to specific features by toggling the icons on/off (shown with ‘Point’ only selected)

Snapping Dropdown has additional options:

- Start/Stop Snapping
- Allows Island Polygon using Cut Polygon Tool
  - With **Point Features** selected, allows snapping to soil polygon **NODEs** only

A topology node; the point where two polygons join
Snapping Dropdown >> Options

Determines screen distance for snapping

Snap tips are popups that indicate (optionally) what layer, snap Type, e.g. Vertex, that you’ve snapped to.

Tip: “Background” provides an opaque text box behind the snap tip which is useful for viewing over dark colors, e.g. imagery
Edge matching Example: Settings limit what Types of feature I can snap to, the snap tips verify that I am snapping to a Node, not a line or vertex.
Snapping

Aside from Edge-matching, snapping is often unnecessary in the development of a digital soil survey. However, it can be useful if you want to begin or end a polygon at a specific point: during edge-matching or across layers, e.g. contours.
Helpful Tips:

- **Space Bar**
  - Hold down the spacebar key to suspend snapping without turning it off
  - This allows you to digitize within the snapping tolerance

- **Revert** back to 9.x snapping environment if you prefer
  - Editor Toolbar >> Editor Dropdown >> Options

![Editing Options dialog box]

The dialog box shown is for adjusting editing options, including settings for display measurements, snapping tolerances, and various other features to enhance the digitizing process.
Stream Digitizing

- Stream digitizing allows the user to draw using the mouse in a smooth fluid motion.

- Vertices are added automatically at a user-defined interval (more vertices may be added with a left click)

- **Beware**, when stream digitizing
  - Easy to create high vertex density, i.e. multiple redundant vertices
  - Easy to create topology errors at first
  - Requires patience and practice
Stream Digitizing - Settings

Editor>Options>General

Stream tolerance is the interval at which vertices will be added, here 50 meters (do not set at less than 30 meters)

Group is the number of points grouped together that will be deleted using the Undo button (or Ctrl Z)
Stream Digitizing

Tips:

The **F8** key toggles between manual and stream mode.

The ‘**C**’ key is a shortcut for the PAN tool. While stream digitizing, be ready to hold down the ‘**C**’ key with your free hand. This will stop the current action, allow you to undo or select another tool.

If using Stream digitizing to cut an island be sure the Snap to Sketch option is turned on.
Snap to and double-click on starting node to complete
Be careful. It is very easy to “double-back” on your line when stream digitizing. This will create sliver polygons or worse...
ArcGIS 10 NAIP Services Tips & Tricks

To access the new APFO image server:

In ArcMap >>
Add Data (scroll to bottom) >>
GIS Servers >>

Add ArcGIS Server >>
Copy/paste the following URL into the wizard dialog box >>
http://services.apfo.usda.gov/arcgis/services
Do not worry about login or password, click Finish.

Next, click on the service >> NAIP >> click on your state (or multiple)
The images are served up in Geographic WGS84.
You will likely see the following warning since we typically work in UTM NAD83:
Click Transformation button, click the following:

**Convert from:** GCS_WGS_1984

**Into:** North America\NAD 1983 (match your data frame projection)

**Using:** 

The imagery in the NAIP folder will be the current year or most recently available. You can verify by checking the imagery date by Quarter Quad (!) in the attribute table. Note that the Quad boundaries are selectable and show up on the image when selected.
Finally, access historical imagery through the NAIP_Historical directory (see instructions below).

Setting up the Time Slider in ArcMap 10 using the State_Historical Services:

1. *You only need to perform this step if you want to see 3rd oldest year of imagery or older. The 2nd oldest year of imagery will be displayed automatically by the State_Historical service.
2. Right Click the desired Image Layer in the TOC and go to the Time tab.
3. Set the layer properties as shown below. Make sure to check Enable Time on this Layer and make sure to hit the calculate button.

![Layer Properties screenshot](image)

4. Hit Ok

5. Click the Time Slider button on the Tools Toolbar
6. Click the Options button in the top left corner

7. Set the Time step interval to 1 year
8. Set the Display date format to yyyy
9. Select the Time Extent Tab
10. Set Restrict Full Time Extent To: Your current layer
11. Make sure you click the Min Time and Max Time buttons (if you did not hit the calculate button in step 3 or if you have added multiple time enabled layers)
12. Hit Ok
13. Start using the Time Slider

*This will need to be done anytime the imagery is added to ArcMap. If the time properties are setup and an MXD is saved, the MXD will store the time properties and you will not need to perform these steps again.

*If multiple states need to be viewed together it may be necessary to disable the time property if the states were not acquired during the same year.
View Metadata on ArcGIS 10 Image Services:

1. Right click the layer in the TOC.
2. Navigate to Data – View Item Description
How to identify the source raster being viewed:

1. Right click the layer in the TOC.
2. Navigate to Selection – Select Visible Rasters

3. Right click the layer in the TOC

4. Navigate to Open Attribute Table
5. Select the Show Selected Records at the bottom of the table.

6. The visible rasters will be displayed.

7. The identify tool can also be used to determine the QQ and majority image data at scales greater than 1:20,000.
How to turn off the ArcMap Default Raster Stretch (2 Standard Deviations) (Non-Conus areas only):

1. Go to the Customize Menu
2. Go to the ArcMap Option Menu
3. Setup your options as shown below:

![ArcMap Options](image)

How to use the Timeliner Add-in:

1. Download Timeliner from this link:
2. Unzip
3. Follow the install procedures provided in the TimelinerUserGuide.pdf
4. Add a NAIP imagery service from APFO into ArcMap
5. Enable Time on the NAIP imagery service by following the procedures listed above (properties – time tab – use the iDate_ts)
6. Click the Timeliner button from the location it was placed following the install procedures
7. Click Settings to Expand the Timeliner Window
8. Click Start

9. The Current Extent box should be populated, a layer should be added to the table of contents and the Timeliner should display the years available with small tick marks.
10. Click the Display tab on Timeliner and make sure the display format is set to YYYY
11. Begin using Timeliner to move between years
12. Refer to the ESRI documentation for further help

How to change the band order to view NAIP CIR.

1. Right Click the Image Layer in the Table of Contents
2. Go to Properties
3. Go to the Symbology Tab
4. Click Band 1 and change it to Band 4
5. Click Band 2 and change it to Band 1
6. Click Band 3 and change it to Band 2
7. Hit Ok.